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Overview
Disk CleanUp is a small disk utility designed to clear previously deleted files. Deleting a file normally just removes the file’s 
directory entry, but the data itself remains on the disk. Disk CleanUp completely eliminates the contents of deleted files.

Disk CleanUp will not delete files from your disk drives, but rather cleans up the empty space on the disk by creating a 
temporary file named CLEANUP.TMP at the root of the drive being cleaned. This file is written to and expanded until the entire 
drive has been cleared. When Disk CleanUp is completed or you press the [Stop] button, or the [Esc] key this temporary file will
automatically be removed.

NSA Erasure Method
Disk CleanUp can be configured to erase files using an NSA approved erasure method. NSA erasures specify that the file be 
written to seven (7) times using an alternating byte write sequence of: 00, FF, 00, FF, 00, FF, F6. Normal Disk CleanUp erasures
simply write the F6 character to deleted files.

Specifying the NSA erasure method will take considerably longer to perform due to the six additional disk writes required. MS 
Windows 95/NT systems make use of a sophisticated disk caching method that delays writing information to the physical disk. In
order to actually write the alternating NSA byte sequence, the disk buffers must be flushed between each write operation. You 
may hear the disk drive being accessed when the NSA method is used. This is perfectly normal and will not harm the drive in 
any way, but the sound that certain drives makes may be a bit loud.

Automate Disk CleanUp
Disk CleanUp for Windows 95/NT can be invoked via a scheduling program using command line arguments. This option allows 
you to automatically clean your drive at a pre-scheduled time.

Desktop Locations
Disk CleanUp’s location on the desktop is saved when the program is exited. Whenever you start Disk CleanUp it will reappear 
on the desktop where you last placed it. Disk CleanUp dialog box locations are also stored and reused the next time they are 
opened.

Taskbar Tray
Disk CleanUp for Windows 95/NT can be optionally configured to place its program icon in the Taskbar Icon Notification Tray. 
This option provides a simple means of keeping the taskbar button region clear for other running programs.



Installing Disk CleanUp
Installation
To install Disk CleanUp for Windows 95/NT on your computer simply create a new, empty folder and place the files; 
CLEANUP.EXE, CLEANUP.HLP and CLEANUP.CNT there.

CLEANUP.EXE - The Disk CleanUp Application
CLEANUP.HLP - The Windows 95/NT Help File
CLEANUP.CNT - The Help Contents File

To integrate Disk CleanUp for Windows 95/NT with the MS Windows Explorer select the Disk CleanUp Explorer Setup dialog 
box while Disk CleanUp is running.

Note If you have an earlier version of Disk CleanUp for Windows 95/NT installed on your computer, simply replace the 
CLEANUP.EXE, CLEANUP.HLP and CLEANUP.CNT files with the newer versions. Disk CleanUp stores configuration 
information in the MS Windows 95/NT System Registry.

Note The CLEANUP.INI file is no longer used and can be deleted. The various application settings specified in the Disk CleanUp
Options dialog box as well as the main window’s size and location on the desktop are now stored in the MS Windows 95/NT 
System Registry.

Note Some earlier versions of Disk CleanUp for Windows 95/NT included a CLEANUP.WRI documentation file. This file has 
been replaced by the CLEANUP.HLP file and can now be deleted.

Warning If you rename the CLEANUP.EXE file you must also rename the HLP file using the same basename. For example if 
you change the Disk CleanUp application file name to NewName.exe, rename the help file to NewName.hlp. The HLP and CNT 
files must reside in the same folder as the Disk CleanUp application file itself.



Configuring Disk CleanUp
Disk CleanUp Options
Select the File | Options menu item to display the Disk CleanUp Options dialog box. This window will allow you to change the 
various Disk CleanUp program settings listed below. Pressing the [Options] button in the main window will also open the Disk 
CleanUp Options dialog box.

Select a Drive to Clean
Use this control to select the drive to be cleaned.

NSA File Erasure Method
Check this item to perform NSA approved file erasures.

Log all Operations to Disk
Check this item to log all Disk CleanUp operations to a disk file. The log file CLEANUP.LOG will be created in the same folder 
that the Disk CleanUp application itself resides in.

Place Icon in Taskbar Tray
Check this item to display a small Disk CleanUp program icon in the Taskbar Icon Notification Tray. If this item is selected and 
the Disk CleanUp window is minimized a button will not be added to the Taskbar, to restore the Disk CleanUp window on the 
desktop press the small icon in the taskbar tray instead. This option is available to keep the taskbar free for other running 
programs.

Minimize Program Icon at Startup
Check this item to open the Disk CleanUp windows and place its minimized icon on the taskbar when the program is first 
launched.

Background Priority for Disk CleanUp
Select the background priority for Disk CleanUp operations. Disk CleanUp uses an MS Windows 95/NT timer for disk cleanup 
operations. One disk cluster will be cleaned each time the Windows timer is invoked. The background priority settings specify 
the time period (in milliseconds) to be used for background cleanup operations.

High = 125 milliseconds
Normal = 250 milliseconds
Low = 500 milliseconds

Warning Sounds with Dialog Boxes
Check this box to play a short beep sound when Disk CleanUp displays a warning dialog box or an error occurs.

OK
Press this button when you have completed your selection of Disk CleanUp program options. When you press this button the 
Disk CleanUp Options dialog box will be closed and your settings will be saved.

Cancel
Press this button to close the Disk CleanUp Options dialog box without making any changes. If you have made any changes 
to the option settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Help
Press this button to open the Disk CleanUp Help Window and go directly to the Configuring Disk CleanUp topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the Disk CleanUp 
Options window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



Disk CleanUp Explorer Setup
Disk CleanUp Explorer Setup
Select the File | Options menu item to open the Disk CleanUp Options dialog box. Select the Explorer tab to display MS 
Windows 95/NT Explorer setup options. This window will allow you to integrate Disk CleanUp for Windows 95/NT with the 
Microsoft Windows 95/NT Explorer. You can also select the Help | Setup menu item to go directly to this window. Use this 
command to create and remove MS Explorer shortcuts for Disk CleanUp for Windows 95/NT.

Create a Start Menu Item
Check this item to create a Disk CleanUp Start Menu entry. The Disk CleanUp for Windows 95/NT program will be located in 
the Software by Design folder on the Programs menu. This item will be disabled (grayed) if a Disk CleanUp item already 
exists in the Software by Design folder.

Remove this Start Menu Item
Check this item to remove the Disk CleanUp entry located in the Software by Design folder on the Programs menu. This item 
will be disabled (grayed) if a Disk CleanUp item does not already exist in the Software by Design folder.

Create a Desktop Icon
Check this item to create a Disk CleanUp for Windows 95/NT program icon on the Explorer desktop. This item will be disabled
(grayed) if a Disk CleanUp desktop icon already exists.

Remove Icon from the Desktop
Check this item to remove the Disk CleanUp for Windows 95/NT program icon from the Explorer desktop. This item will be 
disabled (grayed) if a Disk CleanUp desktop icon does not already exist.

Create a Startup Folder Item
Check this item to automatically run Disk CleanUp for Windows 95/NT whenever Microsoft Windows is started. This option 
creates a Disk CleanUp program icon in the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a Disk 
CleanUp startup item already exists in the Startup folder.

Remove the Startup Folder Item
Check this item to remove Disk CleanUp from the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a
Disk CleanUp startup item does not already exist in the Startup folder.

OK
Press this button when you have completed your selection of MS Explorer shortcuts. When you press this button the Disk 
CleanUp Setup dialog box will be closed and the MS Explorer shortcuts you have selected will be created or removed.

Cancel
Press this button to close the Disk CleanUp Explorer Setup dialog box without creating or removing any MS Explorer 
shortcuts.

Help
Press this button to open the Disk CleanUp Help window and go directly to the Disk CleanUp Explorer Setup topic.



File Menu
File Menu Commands
The File menu provides commands to work with the document files used by Disk CleanUp. A short description of each item 
follows:

Start
This command will start Disk CleanUp on the specified drive. Pressing the [Start] button in the main window will also 
invoke this command. The Ctrl+S shortcut can be used for this command.

Stop
This command will stop Disk CleanUp on the specified drive. Pressing the [Stop] button in the main window will also invoke
this command. The Esc shortcut can be used for this command.

Options
Opens the Disk CleanUp Options dialog box and allows you to change Disk CleanUp program settings. Use this command 
to configure the Disk CleanUp program. . Pressing the [Options] button in the main window will also invoke this command. 
The Ctrl+O shortcut can be used for this command.

Exit
Closes the Disk CleanUp program and returns control to the Explorer desktop. If Disk CleanUp is currently active you will 
be prompted to confirm exiting. The Ctrl+Q shortcut can be used for this command.

Tip Commonly used File commands can be invoked using shortcut keys.



View Menu
View Menu Commands
The View menu provides commands used to change Disk CleanUp display options. These items provide a means of changing 
the Disk CleanUp window appearance. A short description of each item follows:

Minimize
Minimizes the Disk CleanUp window to a button or icon on the taskbar. The Ctrl+Y shortcut can be used for this command.

Always on Top
Use this command to keep the Disk CleanUp window top most on the desktop. When this item is checked the Disk 
CleanUp window will float above all other non-topmost windows on the desktop. This item is useful if you normally run Disk 
CleanUp with a small window that would be easily obscured by other applications. The Ctrl+T shortcut can also be used for
this command

Tip Commonly used View commands can be invoked using shortcut keys.



Help Menu
Help Menu Commands
The Help menu provides commands used to get help with Disk CleanUp operations. A short description of each item follows:

Contents
Opens the Disk CleanUp Help window and displays the Table of Contents. The F1 shortcut can be used for this command.

Search
Opens Disk CleanUp Help and displays the Search window. You can use this window to search for specific Disk CleanUp 
help topics.

How to Use Help
Opens a Help window that explains how to use the MS Windows 95/NT Help program.

Setup
Displays the Disk CleanUp Explorer Setup dialog box. This window provides options to integrate Disk CleanUp with the MS
Windows Explorer. Use this window to create MS Explorer Start Menu items and desktop icons.

Web Site
Opens your web browser application and goes directly to the Software by Design web site on the Internet.

About Disk CleanUp
Displays the Disk CleanUp splash box. This window contains program information, the current version of Disk CleanUp you
are running and a program copyright notice. Click the mouse anywhere in this window to close it

Tip Commonly used Help commands can be invoked using shortcut keys.



Shortcut Keys
Shortcuts
Shortcut keys allow you to quickly invoke Disk CleanUp menu commands without first displaying the menu and then selecting an
item from it. The most commonly used Disk CleanUp commands can be invoked using the following shortcut keys.

File Menu
Ctrl+S Start Disk CleanUp
Esc Stop Disk CleanUp
Ctrl+O Open the Disk CleanUp Options dialog
Ctrl+Q Exit Disk CleanUp and return to the desktop.

View Menu
Ctrl+Y Minimize Disk CleanUp to a button or icon
Ctrl+T Make window topmost

Help Menu
F1 Display this Help file



Command Line Arguments
Command Line Arguments
Disk CleanUp can be invoked using command line parameters. If command line parameters are detected at launch time Disk 
CleanUp will start running and when completed exit automatically. If you use a scheduling program such as the Microsoft 
Windows System Agent or my Reminders for Windows 95/NT to automatically launch programs use the following command line 
switches to automate your disk drive cleanup.

CLEANUP d: [/nsa|/nonsa] [/log|/nolog] [/high|/normal|/low] [/tray|/notray] [/min]

d: Drive to be cleaned (must be the first argument)

/nsa Use the NSA erasure method
/nonsa Skip NSA erasures

/log Create a log file of all operations
/nolog Skip logging operations

/high High background priority
/normal Normal background priority
/low Low background priority

/tray Place icon in tray
/notray Remove icon from tray

/min Start with a minimized window



Troubleshooting FAQs
Troubleshooting FAQs
This is a compilation of frequently asked questions I’ve received from users. If you have a question that is not addressed below 
please feel free to contact me. I’ll try to help you use Disk CleanUp for Windows 95/NT with your system.

Can Disk CleanUp be used with Compressed Drives?
No. Disk CleanUp is designed to clean normally formatted disk drives. If you have configured your system to use disk 
compression do not use Disk CleanUp to clean your compressed drives.

Can Disk CleanUp be used with FAT32 drives?
No. Disk CleanUp is designed to clean FAT16 disk drives. If your system is configured to use FAT32 file allocation tables do 
not use Disk CleanUp to clean those drives.

Can Disk CleanUp be used with really large hard drives?
Disk CleanUp is designed to clean disk drives up to 2.2 gigabytes. If your system has hard drives larger then 2.2 gigabytes do
not use Disk CleanUp to clean those hard drives.

Disk CleanUp takes a long time, is this normal?
Yes. If you have specified the NSA file erasure method this is normal. NSA disk erasure take considerably longer to perform 
than normal cleaning operations. If you clean your drive regularly you may not need to use this option. Large fixed disks may 
take well over an hour to clear if they contain large amounts of unused file space.

Can I use Disk CleanUp with floppy disks?
Yes. Disk CleanUp will work with any device that supports writing to the media (unlike CD ROM disks which are read-only 
devices.) Cleaning floppy drives will take slightly longer due to the slower data transfer speed inherent in floppy drive 
mechanisms.

Can Disk CleanUp be run automatically?
Yes. See the Command Line Arguments section of this help file for a complete description of running Disk CleanUp for 
Windows 95/NT automatically at a scheduled time.

Will Disk CleanUp delete old files for me?
No. Disk CleanUp clears empty disk space on a specified drive. You must use the MS Windows Explorer or one of the several
disk utilities available to remove your unwanted files.

My system crashed while Disk CleanUp was active!
Check for the file CLEANUP.TMP at the root of the drive you were running Disk CleanUp on when your system crashed and 
delete it. This file would normally be found at either C:\CLEANUP.TMP or D:\CLEANUP.TMP. If removing this file doesn’t 
recover the missing disk space on the drive run the MS Windows 95/NT disk scanning program C:\Windows\ScanDskw.exe to
check the drive you were cleaning when the system failed.



Comments and Upgrades
Comments and Suggestions
If you have comments, questions or find any bugs in Disk CleanUp for Windows 95/NT please feel free to contact me on 
CompuServe.

Upgrade Notification
If you would like to be notified when this application is upgraded send me an email message with your online address. Please 
include the version number of Disk CleanUp that you are using and the location that you downloaded my software from.    I will 
email you when a new version of Disk CleanUp for Windows 95/NT is uploaded to my web site on the Internet, CompuServe, 
ExecPC, ZD Net, and MSN.

Gregory Braun
CompuServe: 71613,2175
Email: 71613.2175@compuserve.com
Web Site: http://www.execpc.com/~sbd
Phone: 1.414.444.8497

Contributions
While Disk CleanUp is offered as Freeware, if you would like to pay for it you are welcome to send any amount you wish to:

Gregory Braun
5609 West Hadley Street
Milwaukee, WI 53210-1554    USA

Your contributions are always welcome, and encourage me to continue developing new applications.

Web Site
Visit my web site on the Internet to download the latest versions of all of my freeware offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)



Release History
Disk CleanUp for Windows 95/NT Release History

v2.0 Original in-house development and testing of MS Windows 95/NT conversion using the Microsoft Win32 SDK.

v2.1 Added 95/NT splash box for release.

v2.2 Added options to place the program icon in the taskbar notification tray, and to save the desktop locations of all dialog 
boxes. 

v2.3 Added support for screen colors settings as specified in the Display Properties dialog. Added default user and company 
name to the splash box. 

v2.4 Replaced the CLEANUP.INI file with MS Windows 95/NT System Registry entries. Added MS Windows 95/NT Help file. 

v2.5 Added Explorer Setup facility. Added the /min command line argument. Added test for compressed disk volumes.

v2.6 Added an option to start the program as a minimized icon on the taskbar. Added help buttons to the various Disk 
CleanUp dialog boxes.

v2.7 Converted the Disk CleanUp Options dialog box to a three-tab property sheet. Fixed several minor bugs.

v2.8 Fixed a bug that prevented proper window repositioning when the MS Explorer Taskbar was placed along the left edge or
at the top of the desktop and the Auto hide option was active.

v2.9 Fixed several minor bugs.

Last Update January 10th, 1998

Web Site
Visit my web site on the Internet to download the latest versions of all of my freeware offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)



System Registry
Disk CleanUp for Windows 95/NT System Registry Key
Disk CleanUp for Windows 95/NT stores configuration settings in the MS Windows 95/NT System Registry. These settings are 
updated automatically while Disk CleanUp is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. Disk CleanUp automatically updates registry entries when it 
exits. If you edit these settings make sure Disk CleanUp is not running while you edit them. If Disk CleanUp is currently running 
your changes will be overwritten when Disk CleanUp exits.

Disk CleanUp for Windows 95/NT stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software

Software by Design
Disk CleanUp for Windows 95/NT

Section
Label = Value

Warning There is no need to edit these settings manually. Disk CleanUp will automatically maintain these settings for you. If you
do edit these, you do so at your own risk.



Removing Disk CleanUp
Removing Disk CleanUp for Windows 95/NT
If you find that Disk CleanUp for Windows 95/NT does not meet your needs you can remove it from your computer system by 
simply deleting the following files from your hard drive. All of these files will be located in the folder that you originally installed 
Disk CleanUp in.

CleanUp.exe Disk CleanUp for Windows 95/NT application program.
CleanUp.cnt Disk CleanUp Help Topics File
CleanUp.hlp Disk CleanUp Help File

If you have opened and used the Disk CleanUp for Windows 95/NT Help files your system may contain the following two (2) 
files. These files are created by the standard MS Windows 95/NT Help program WinHlp32.exe. These files may also be safely 
removed.

CleanUp.gid MS Windows Help settings file. This file contains the Disk CleanUp Help window size and desktop 
location as well as any bookmarks you may have created.

CleanUp.fts MS Windows Help word database. This file is created when you build a custom word list for Disk CleanUp
Help files. This file is used to search for words and phrases in the Disk CleanUp Help files.

Disk CleanUp for Windows 95/NT does not use any custom DLL files or system drivers. If you delete the files mentioned above 
from your system’s hard drive you will have completely removed Disk CleanUp from your computer system.

Note If you have installed Disk CleanUp shortcuts on the MS Explorer Start Menu use the Help | Setup command to remove the
shortcuts you created before you delete the Disk CleanUp files mentioned above.



Software by Design Web Site
Software by Design
You can download the latest versions of all of my freeware from my web site on the Internet. I post the latest releases of my 
software there first. Click your mouse on the link listed below to visit the Software by Design web site.

Software by Design Web Site

(http://www.execpc.com/~sbd)

Freeware Titles
The following software titles are available at my web site on the Internet and can also be found on CompuServe, ExecPC, MSN 
and ZD Net.

NoteBook for Windows (NBOOK.ZIP)
NoteBook for Windows 95/NT (NBOOK32.ZIP)
Reminders for Windows (REMIND.ZIP)
Reminders for Windows 95/NT (REMIND32.ZIP)
ToolBar for Windows (TBAR.ZIP)
ToolBar for Windows 95/NT (TBAR32.ZIP)
Screen Loupe for Windows (LOUPE.ZIP)
Screen Loupe for Windows 95/NT (LOUPE32.ZIP)
Screen Loupe for Macintosh (LOUPE.SEA)
Audition for Windows 95/NT (AUDITION.ZIP)
Password Keeper for Windows 95/NT (PASSKEEP.ZIP)
CardBase for Windows 95/NT (CARDBASE.ZIP)
File Editor for Windows (FXEDIT.ZIP)
File Editor for Windows 95/NT (FXEDIT32.ZIP)
Crypto for Windows 95/NT (CRYPTO.ZIP)
Icon Extractor for Windows (ICONX.ZIP)
Icon Extractor for Windows 95/NT (ICONX32.ZIP)
TxEdit for Windows 95/NT (TXEDIT.ZIP)
DLL Show for Windows 95 (DLLSHOW.ZIP)
RGB Editor for Windows (RGB.ZIP)
RGB Editor for Windows 95/NT (RGB32.ZIP)
Quiz Wizard for Windows 95/NT (QUIZWIZ.ZIP)
FontShow for Windows 95/NT (FONTSHOW.ZIP)
Programmer's IDE (PMAN.ZIP)
Programmer's IDE 95/NT (PMAN32.ZIP)
Touch for Windows (WTOUCH.ZIP)
Disk CleanUp for Windows 95/NT (CLEANUP.ZIP)
BattleStar for Windows (BSTAR.ZIP)
BattleStar for Windows 95/NT (BSTAR32.ZIP)
World Radio for Macintosh (WRADIO.SEA)

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online 
services may be earlier releases.



BBS and Internet Operators
Webmasters
Please upload the original ZIP file intact and title the submission:

"Disk CleanUp for Windows 95/NT v2.9"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my freeware offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)

Note This site also supports anonymous FTP transfers.






